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Abstrakt

Tématem této prace je tvorba 3D mod&sti obce Kojkovice uiince. Je popsan postup
méieni a zpracovani natfenych dat. Déle je podrobuiveden postup tvorby TIN z dat
nantienych i z dat ZABAGED poskytnutyadhUZK. Model je vytvden v softwaru ArcMap s
pouzitim nadstavby 3D Analyst. Oba modely jsou e vzajemr porovnany. Vysledkem
prace je digitalni model terénu vybraného tuzemi.

Kli ¢ova slova
3D model, DMT, ArcGIS, GIS, Kojkovice, 3D Analyst|N

Abstract

The topic of this thesis is creation of 3D modepaft of Kojkovice municipality nearby
Tiinec. It describes the procedure of measuring anckegsing measured data. Next part
contains detailed process of creation of the TIbkh lfrom measured data and from
ZABAGED data granted b UZK. Model is created using software ArcMap with 3D
Analyst extension. Both models are then comparbd.résult of the thesis is a digital terrain
model of chosen area.
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3D model, DTM, ArcGIS, GIS, Kojkovice, 3D Analyst|N
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1. Uvob

Hlavnim cilem této bakalarské prace je zaméieni vybrané lokality pro vytvoieni
digitalniho modelu terénu vybrané lokality na okraji mésta Ttince. Prace je Clenéna

chronologicky, v kazdé kapitole je popsana jak teoreticka ¢ast, tak i prakticky postup.

Na zacatku je popsana lokalita a technologie métfeni. Meéfeni bylo pomérné
narocné, jde o jamy pozustalé po t€zbé¢ vapence, velmi husté porostlé kfovinami. Aby
mohly byt tvary terénu zachyceny, bylo naméteno celkem 904 podrobnych boda. Pro
$patnou dohlednost bylo nutno vytvofit hustou sit’ pomocnych métickych bodi. Cast byla

uréena polygonovymi porady, dal$i metodou rajonu.

Ve druhé kapitole jsou uvedené pouzité metody vypocti. Je popsan postup
zpracovani naméfenych dat, ktery probéhl v geodetickém programu Groma. V ném byly
vypocteny polygonové potady a nasledné€ ostatni body pomocné méfické sit¢. VSechny tyto

body byly dale pfedmétem sitového vyrovnani.

V dalsi kapitole se nachdzi vysvétleni pojmu GIS a pfiblizeni problematiky
digitdlniho modelu terénu. Také je tu popsan pouzity podklad ZABAGED, a software

ArcGis, ve kterém je tvofen 3D model.

Posledni kapitola je zamétena na prakticky postup pii tvorbé digitadlniho modelu
terénu od importu dat aZ po vytvofeni vystupil. Je zde také uvedeno porovnani modelu

vytvofeného z namétenych dat s modelem ZABAGED.
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2. MERICKE PRACE
2.1. Popis lokality

Zvolena lokalita se nachazi na okraji mésta Ttince, nedaleko cesko-polské
hranice. Jedna se o uzemi, ve kterém se v minulosti t€zil vapenec, nyni se tedy sklada
predevs§im z vytézenych jam a nahromadénych kup. Celd lokalita je velmi husté porostla
naletovymi dievinami, jako je napiiklad habr a také kiovinami: trnkami a ¢ernym bezem.

Plocha mapovaného uzemi je 4,5 ha.

Obvod mapovaného tzemi je graficky znazornén na na Obr. 1. Méteni mélo

slouzit krom¢ zpracovani této prace také k vypoctu kubatur vytéZzenych jam.

Obr. 2, 3 — Fotografie lokality

11
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2.2. Prubéh méfeni

Rekognoskace terénu probéhla za¢atkem &ervence roku 2012. Cast lokality byla
zaméiena v nékolika nasledujicich dnech, zbyla ¢ast pak az na podzim, kdy se nasledkem
opadani listi velmi znateln¢ zvySila dohlednost a tudiz i dosah totalni stanice a obecné
efektivita méfeni. Vzhled lokality je piiblizen na Obr. 2 a 3.

Lokalita byla méfena postupné, tak jak to umozioval terén. lhned po stabilizaci
pomocného méfického bodu nasledovalo zaméfeni osnovy sméri na iz
stabilizované viditelné body, vybér vhodného mista pro dal$si pomocné métické body a

jejich stabilizace a zaméfeni, a zaroven méfeni podrobnych bodia. Stabilizace byla

realizovana kovovym hrotem nebo dievénym kolikem.

Meéficka sit’ byla do S-JTSK pfipojena méfenim na trigonometrickém bodé
937220140, zajistovacim bod¢ 937220143 a bodech podrobného polohového bodového
pole (PPBP) 000000514 a 000000521. Osnovy sméri byly orientovany také na bod
000000513 a vzdalenéjsi body 937230040 (véz kostela v Ttinci) a 937230021 (vysila¢ na
Javorovém). Dale m¢l byt ve vychodni ¢asti lokality pro kvalitngj$i pfipojeni zaméten
metodou GNSS bod 4001, avsak toto méfeni se z riiznych diivodi neuskuteénilo a na tento
bod tedy ani nebylo métfeno. Vyskové byly pomocné méfické body do systému Bpv

piipojeny na tytéz znamé body a jejich vyska je vypoctena trigonometricky.

Podrobné body byly zaméfeny tachymetrickou metodou soucasné s métenim
méfické sité€. Rozmisténi podrobnych bodt bylo voleno tak, aby bylo mozné co nejlépe
vystihnout tvar terénu a objem jam respektive kup. Hustota bodii je 5 — 20 metri, lisi se

podle cClenitosti terénu. V méfitku mapy 1:500 to odpovida vzdalenosti 10 — 40 mm.

Naméfena data byla registrovana do paméti totalni stanice Trimble Zeiss
3603 DR. Zapisniky méfeni jsou obsahem piilohy ¢. 1. Celkem bylo zaméteno 904

podrobnych bodu ze 48 stanovisek.
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2.3. Totélni stanice Trimble Zeiss 3603 DR

Pro méteni polohopisu a vyskopisu byla
pouzita totalni stanice Trimble Zeiss 3603 DR.
Ptistroj umoziiuje méteni vzdalenosti v hranolovém
1 bezhranolovém modu, méfené veliCiny lze
zaznamenavat do paméti pristroje. Neékteré
technické parametry pfistroje jsou uvedeny

Vv nasledujici tabulce.

Tab.1 — Technické parametry Trimble Zeiss
3603 DR

Zvétseni dalekohledu 30x

Presnost méreni Ghld 0.9 mgon

Presnost méreni délek -

2mm + 2 ppm
hranol

Obr. 4 — Trimble Zeiss 3603 DR

Presnost méreni uhld -
3mm+2 ppm

DR méd (bezhranolovy)

2.4. Méfické nacrty

V prib¢hu méteni bylo vyhotoveno celkem 9 métickych nacrta.

Jedinym, jako podklad pouZitelnym, polohopisnym prvkem v lokalité je silnice, a
tak byly nacérty kresleny na cisty, obycCejny papir formatu A4. Tyto nacrty byly vSak uz
Vv prib&hu méteni témét Gplné znieny. Na viné je hlavné naro¢nost terénu a také neptizen
pocasi. I kdyz je to proti logice jejich pofizovani, nacrty byly piekresleny a tyto
piekreslené a adjustované nacrty jsou obsahem ptilohy €. 2. Ukéazka néacrtu €. 5 je uvedena

na Obr. 5.
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Obr. 5 Ukadzka mérického nacrtu

14




3D model obce Kojkovice u Tfince
Eﬂﬁﬂ Krzysztof Szturc

3. VYPOCETNIi PRACE

3.1. Vypocetni metody

3.1.1. Polygonovy potad

Polygonovy pofad je definovan jako primét prostorové lomené Cary do roviny.
Jeho vrcholy jsou polygonové body. Spojnice polygonovych bodu se nazyvaji polygonové
strany. Kurceni polohy polygonovych bodi se méfi na polygonovych bodech osnovy
smérl, z nichz se urci vrcholové thly. Délky stran se méfi dvakrat, tam a zpét. Orientace
poradl se déje smerovym pifipojenim z koncovych bodl na body zakladniho polohového
bodového pole (ZPBP), zhustovaci body abody PBPP. Znaméfenych smért se na

koncovych bodech vypocitaji orientované jizniky.
Polygonové pofady miizeme rozd¢lit na:

Oboustranné pripojené a oboustranné orientované

a.
b.  Oboustranné pfipojené a jednostranné orientované

o

Vetknuté — oboustranné ptipojené, bez orientaci

o

Volné — jednostranné pfipojené a jednostranné orientované
e. Uzavfené — orientace na pocatecnim bodé¢, potrad zafind a kon¢i na stejném
bodé

f.  Uzavfené neorientované — v mistni soufadnicové soustaveé

(Nevosad, 2005, s. 59)

AN

&r

Obr. 6 — Vypocet polygonového poradu (Nevosad, 2005)
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V nasem piipadé byly pouzity pouze polygonové pofady oboustranné ptipojené
a orientované. U tohoto typu polygonového poradu jsou dany soutradnice pocatecniho
a koncového bodu A (X,, Y,), B (Xg, Yg) a soufadnice dalsich bodu pro orientaci osnovy
smérd. K uréeni orientovaného jizniku a,; na pocatecnim bod¢, ag; na koncovém bode
jsou méfeny osnovy smérti Y ; ,p; a na polygonovych bodech sméry ¥;_; ;41 KurCeni

w';. Dale pak délky polygonovych stran s; ;41 Viz Obr. 5.
U tohoto typu potfadu jsou méfeny tfi nadbytecné veliCiny, dochazi tedy
k vyrovnani thlovému a soutadnicovému. Vypocet probiha v nasledujicich krocich:

1. Ze soutadnic danych bodd a z méfenych osnov na pocatecnim a koncovém bodé

se vypoctou orientované jizniky a4, @p3.
2. Z naméfenych smért na vrcholech pofadu se vypoctou vrcholové uhly w';.

!/
Wi =Piiv1 — Yiioa

3. Zorientovanych smérti ayq,ags; a vrcholovych Ghli w’; se vypocte Ghlovy
uzavér 0.

!
0, = apz — A p3,
kde a'33 = ay1 + Z?:l (,l)’i — i2R.

4. Vypocteny thlovy uzavér O, se porovna s dovolenou odchylkou Aw, je-li splnéna
podminka |0, | < Aw, pokracuje se dale ve vypoctu. V piipadé piekroceni Aw
je nutno po ovéteni danych a méfenych veli¢in méfeni zopakovat.

5. Vypoclteny uzavér O, se rovnomémé rozdéli na vrcholové uhly w'; ale ina

orientované jizniky a4, ap3.
— Ow ] — ! ] ! — ] ! —
Vo =7 5 Wi =W+ V5 @1 =0 TV, Xps=ap3+ Uy,
kde n je pocet bodii, na kterych bylo méfeno.
6. Vypocitaji se vyrovnané jizniky.
— ! .
Op1 = A g1+ Vy, 5

012 :O',A1+(1)1_2R.

7. Vypocet piibliznych soufadnicovych rozdild AX;;.,, AY;;11 Z vyrovnanych

Jiznikl 0; ;44 a délek stran s; ;41 .

16
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AX',q = S41* COSOyq AY' 41 = Suq + Sinay,
: ; :
AX,B3 =SB3 'COSO-Bg AY’B3 =SB3 'Sin0'33
4 4
! — . ! — 3
AX'yp = Z Sii+1°€C0S0O;i41 ;5 AY 4p = z Sii+1 * SN0 141
1 1

8. Vypoctou se soufadnicové uzaveéry Oy , Oy ze soutfadnicovych rozdilti danych bodu

AX,p, AY,s a ze soufadnicovych rozdildi — AX',5,AY 45 vypoctenych

Vv predchozim kroku.
Ox = AXyp —AX'pp; Oy = AYpp — AY'pp.

9. Vypocte se polohovy uzavér Op,

Op = /0§+0Y2.

Porovnd se smezni hodnotou odchylky polohového uzavéru, ta zavisi na
pozadované ptesnosti. V ptipadé jejiho prekroceni je nutno ovétit dané a mérené

veli€iny a méfeni zopakovat.
10. Vypoctou se opravy a vyrovnané soufadnicové rozdily AX; ;1 ,AY; 41.

VXiivn = n—1"~ VyYiier = n—1"

AXijivr = DX jip1 + Vx5 AViier =AY i + vy,
11. Vypoctou se vyrovnané soufadnice polygonovych bodd.
X1 =Xg+ 80Xy 5 =Y, + AV,
X, =X, +AX:, ; Yo, =Y +AY;,
X; =X, +AXy5 ;5 Y3 =Y, + AY,3

XB :X3+AX3B ) YB :Y3+AY3B

(Nevosad, 2005, s. 61)

17
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3.1.2. Rajon

Rajonem se rozumi orientovana a délkové zamétena spojnice daného a ur¢ovaného bodu.
Jsou dany soufadnice bodu A (X4, Y4) a dalsi body o danych soutfadnicich B(Xg,Ygs)...
K urceni orientovaného jizniku a,p. Zprostiedkujicimi veli¢inami jsou méfena délka s,p a

méfené sméry ; ;41 na daném bod¢ A.

Obr. 7 — Vypocet rajonu (Nevosad, 2005)
Soutadnice bodu P 1ze urcit pomoci rovnic
Xp =Xy +Sup-cosayp = X4 +AXyp,
Yo =Y, +5s4p-sinayp =Y, + AYyp,
kde AXyp=Xp—X4, AVup =Yp —Y,.

(Nevosad, 2005, s. 57)

3.1.3. Tachymetrie

Tachymetrie je metoda méteni, kterou urcujeme polohu i vysku bodu soucasné.
Poloha a vySka jednotlivych bodl se ziskavaji meéfenim polarnich soufadnic tj.
vodorovného uwhlu, svislého Uhlu a Sikmé délky ze stanoviska k jednotlivym bodim.
PtevysSeni mezi urovanym bodem a stanoviskem se pocitaji z métené délky a zenitového
uhlu. Osnovy métenych vodorovnych smért se orientuji pomoci smérnikd vypoctenych ze
Soufadnic stanoviska a danych bodi v okoli, jejichz soufadnice jsou znamy.
(Vondrak, 2004, s. 19).

18
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Urceni rovinnych soufadnic se provadi metodou rajonu, viz pfedchozi kapitola.

Prevyseni bodu A a B se urci podle Obr. 8. ze vzorce

AHyg = s’ - cosz + vs — 1,

S
Obr. 8 — Trigonometrické urceni vysky (Cada, 2011)

3.1.4. Sitové vyrovnani metodou nejmensich ¢tverct
Vyrovnani probéhlo pomoci modulu vyrovnani sité¢ v programu Groma.

Sit je vyrovnavdna metodou nejmensich ctverci. Pro vypocet je pouzit
propracovany a ovéteny algoritmus vyrovnani zprostfedkujicich méteni, ktery je vyvijen a

testovan na CVUT Praha od roku 1982.

Program umozZiiuje vypocet jakéhokoli typu vazané i volné sité. Vazana sit’ je
umisténa do referen¢niho systému pomoci zadanych pevnych bodd, jejich soutadnice se
vyrovnanim neméni. Volna sit' je umisténa pomoci Helmertovy transformace, bud’ na

vSechny, nebo na vybrané body sit¢.

Kazdému bodu miiZzete pfifadit dvé charakteristiky, které definuji, jakym
zpusobem se bod bude podilet na vyrovnani a umisténi sité. Charakteristika bodu se zadava
oddé€len¢ pro polohu a pro vysku, bod miize tedy mit napt. pevnou polohu a ur€ovanou

vysku. (Groma - Rozsifujici modul pro vyrovnani sitit MNC, 2010)
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3.2. Postup vypocétu

3.2.1. Vypocet méticke sité

Vypocet soufadnic jak bodl pomocné meéfické sité, tak 1 podrobnych bodl
probéhl v geodetickém programu Groma, byla pouzita starSi verze tohoto programu —
Groma 7. Ztoho divodu jsou ve vypocetnich protokolech a v seznamech soufadnic
pouzity jesté 12-mistna cisla bodu, kterd by méla byt podle vyhl. ¢. 357/2013 Sb. jiz 9-

mistna.

Jako prvni byl nacten z textového souboru seznam soutadnic danych boda. Ze
soufadnic trigonometrického bodu 937220140, ktery se nachazi ptiblizné€ ve sttedu méfené
lokality, byly vypoéteny korekce ze zobrazovaci roviny a z nadmoiské vysky, které byly
nasledné zavedeny pii importu zapisniku méfeni. Zapisnik byl naéten ve formatu *.zap, je
v ptiloze ¢. 1. Zapisnik byl pted vypocty editovan, konkrétné byly slouceny osnovy smért

meéfené dvakrat na stejnych bodech a spocitana prevyseni.

Nasledoval vypocet soufadnic pomocnych méfickych bodi. Tam kde to bylo
mozné, byly soufadnice vypocéteny metodou polygonovych potadd. Program Groma
umoznuje provést vypocet polygonovych pofadii velmi intuitivn€é, nacte se zépisnik,
a nasledné program sam nabizi mozné body potadu. Vypocet je zobrazen na Obr. 9. Prvni
dva potady vedou mezi body polohového bodového pole a dalsi ¢tyfi porady mezi jiz takto
uréenymi pomocnymi méfickymi body:

e 037220140 -937220143
e (000000514 —000000521
e 4017 -4031

e 4002 -937220140

e 4005-937220140

o 4044 -4013

Z divodu nepiehlednosti terénu nebyly u nékterych pofadi dodrzeny pozadované

geometrické parametry a také se u n€kterych vyskytly ptekro¢ené mezni odchylky.
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Obr. 9 — Vypocet polygonového poradu v programu Groma

V dal§$im kroku byly ze soufadnic bodii uréenych polygonovymi potady
vypocteny dalsi stanoviska zaméfené rajonem, pomoci funkce Poldrni metoda davkou.
V zapisniku byly oznaCeny pouze body meéftické sité tak, aby zatim nebyly pocitany
soufadnice podrobnych bodti. Mezni odchylka v uhlu byla ptekrocena na jednom bod¢, kde
byla méfend velmi kratkd vzdalenost na sousedni stanovisko. Protokoly o vypoctech

polygonovych potadi i poldrni metody jsou obsahem pfilohy ¢. 3.1.
3.2.2. Vyrovnani sité a vypocet podrobnych boda

Po vypoctu souradnic bodl polygonovych pofadd a rajoni bylo dale provedeno
sitové vyrovnani. Groma pro tento vypocet nabizi pfidavny modul Vyrovnani sité. Byl
vybran zépisnik a z ného automaticky nactena data. Doposud vypoctené soufadnice a
vysky bodli pomocné métické sité byly pouzity jako pfiblizné, pouze u bodl zakladniho a
podrobného polohového bodového pole byla poloha a vyska zvolena jako pevna. Probehl
vypocet, soufadnice a vysky pomocnych métickych bodu byly vyrovnany a nasledné byly
vypocteny podrobné body pomoci funkce Poladrni metoda davkou. Byl ulozen protokol a
soufadnice byly exportovany do textovych soubord (piilohy ¢. 3.2, 3.3 a 4). Prostiedi

vypoctu vyrovnani site€ je zobrazeno na Obr. 10.

Stfedni soufadnicové chyby vyrovnanych bodi se pohybuji od 6 mm do 45 mm,
pramérnd hodnota je 28 mm. Stiedni chyby vyrovnanych vysek dosahuji hodnot od 6 mm

do 16 mm, pfi¢emz pramérna stfedni chyba vyrovnané vysky je 11 mm.
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Obr. 10 — Vyrovnani sité v programu Groma

3.1. Tvorba uéelové mapy VvV programu MicroStation

V programu Microstation 95 byl zalozen novy vykres a pomoci nadstavby MGEO
nacteny soufadnice bodi. Nasledné byla podle méfickych nacérti vytvotrena kresba
polohopisu. Atributy prvkt byly voleny podle Pokynu pro tvorbu ucelové mapy. (Tab. 2)
(KALVODA, 2011). M¢titko mapy bylo zvoleno 1:500. Mapové znacky byly vkladany
Z knihovny buné€k geo1000 v7.cel.

Pozdé&ji, po exportu vrstevnic z vytvoireného modelu byl cely vykres otevien ve
verzi MicroStationu V8 a vlozeny do ného vyexportované vrstevnice. Ugelova mapa se
nachazi v ptiloze €. 6.

Dokoncena ti¢elovad mapa byla pouZita jako podklad pro vytvotfeni ptehledného

nacrtu pomocné meéticke sité, ktery je obsahem piilohy €. 7.
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Tab. 2. Tabulka atributii pouzitych prvkii

3D model obce Kojkovice u Tfince
Krzysztof Szturc

Vyska Sitka
Obsah Vrstva Barva Styl Tloustka | Znacka Font [mm] [mm] | Pozndmka
Vypnuto
Body (elementy) 1 0 0 2 pro tisk
Vypnuto
Podrobné body - ¢isla 2 0 0 0 159 1,519 | 1,5-1,9 pro tisk
Podrobné body - vysky 3 70 0 0 158 1,519 | 1,5-1,9
Podrobné vyskobé body - vysky Vypnuto
(netisknuté) 4 70 0 0 pro tisk
Podrobné vyskové body (terén) -
znacky 5 70 0 0 9.12
Body bodovych poli a pomocné
méfické body - ¢isla 6 0 0 0 160 1,9-2,3 | 1,9-2,3
Body bodovych poli a pomocné
mérické body - vysky 7 70 0 0 160 1,9-2,3 | 1,9-2,3
Body bodovych poli a pomocné 1.01-
mérické body - znacky 8 0 0 0 1.04; 1.7
Cesty, chodniky, okap. chodniky,
schody 15 0 0 0
Hranice kultur 16 146 0 0
Druhy pozemk( - bodové znacky 16 146 0 0
Vrstevnice zakladni 24 70 4.1 0
Vrstevnice zdUraznéna 25 70 9.3 2
Popis ploch 35 0 0 0 159 1.6 1.6
Préseciky sité pravouhlych
souradnic, rohy mapovych listl 62 0 0 0 Krizek
Tab1i;
Popisova tabulka 63 0 0 0 Tab2
Okrajové nacrtky 61 0 0 0
Smeérova ruZice (orientace k
severu) 62 0 0 0 Sever
Ohraniceni vykresu 63 0 0 0
Popis prusecik sité pravouhlych
souradnic 62 0 0 0 160 1.9 1.9
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4. GEOGRAFICKE INFORMACNI SYSTEMY

Geograficky informac¢ni systém (GIS) spojuje hardware, software, ziskavani dat,
spravu, analyzu a zobrazeni vSech forem geograficky vztazené informace. GIS umoznuje
prohlizet, chapat, tazat se, interpretovat a vizualizovat data, ktera odhaluji vztahy, struktury

a trendy v podob¢ map, globi, vypist a grafii.

Data GIS jsou v databazi uchovavana ve vrstvach, kazda vrstva pro jiny druh
informace. Tyto vrstvy mohou obsahovat data v podobé bodi (napi. hustota obyvatel), linii
(ficni sit’, komunikace) nebo polygonil (staty, okresy). Dal§i moznosti je rastrovy model,

kde kazdému bodu rastru odpovida ¢iselnd hodnota (napt. mnozstvi srazek).

GIS umoznuje (v zavislosti na obsazenych datech) fesit otazky, jako napf.
vyhledat nejkrat$i cestu mezi body, najit nejvhodnéj$i misto pro vystavbu, zobrazit

zaplavové tizemi a zjistit kolik v ném Zije obyvatel atd.

4.1. Diqitdlni model terénu

Vyznam terminu ,,Digitalni model terénu* neni zdaleka tak jasny, jak by se na
prvni pohled mohlo zdat. PfedevSim pod pojmem ,,terén* byva nékdy mysleno vic, nez jen
reliéf zemského povrchu, ale i vodstvo, hranice kultur a spravnich celki, prosté vétSina
toho, co byva zobrazeno na topografickych mapach. Déle pak se pod digitdlnim modelem

mize myslet i jisté programové vybaveni pro feSeni riznych tloh na terénu. (Urban, 1991)

4.2. Typy terénnich modelu

4.2.3. Polyedricky model — Elementarnimi ploskami jsou Vtomto pftipadé
nepravidelné rovinné trojuhelniky, které k sobé pfiléhaji a tvofi tak
nepravidelny mnohostén, ktery se pfimyké k terénu. Vrcholy mnohosténu jsou
body na terénni ploSe, soufadnicov€ urcené piislusSnymi geodetickymi
metodami. Interpolace se obvykle provadi linearné v trojuhelnicich.

4.2.4. Rastrovy model — Jak sdm nazev napovida, je dan mnozinou elementarnich
plosek nad oky pravidelného rastru. Jsou to vlastné zborcené ctyfuhelniky, které

vvvvvv

plochy.
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Vrcholy, ¢i spise uzly pravidelné sit¢ obvykle nebyvaji pfimo métené, ale jsou
odvozené urlitym vypocetnim postupem. Pravidelné usporadani dat v matici
predstavuje oproti polyedrickému modelu znacné vyhody. Je vSak ziejmé, ze
hranice elementarnich plosek nemohou sledovat prib¢h singularit, coz mtze
byt na zdvadu piesnosti, neni-li rastr dost husty.

4.2.5. Platovy model — Tento typ modelu piedpokldda, ze se povrch rozdéli na
nepravidelné, obecné kiivé plosky trojuhelnikového nebo ctyithelnikového
tvaru, pficemz hranice déleni se vedou po singularitach (mista, kde je hladkost
terénu narusena, napi. terénni stupeni; matematicky nespojitost derivace, ¢i
nespojitost funkce). Tento zpuisob popisu nepravidelnych kiivych ploch byl

prvné pouzit v primyslovém designu, odkud téz pochazi termin plat.

Krom¢ téchto typd, kde je terén charakterizovan elementarnimi ploskami je
mozné terén charakterizovat napiiklad vrstevnicemi v elektronické podobé, nebo jinymi

charakteristickymi ¢arami. (Urban, 1991,s.5-7)

4.3. Zakladni baze geografickych dat

Jako vhodny podklad pro tvorbu 3D modelu terénu byla vybrana Zakladni baze
geografickych dat Ceské republiky, kterou spravuje Cesky uiad zeméméticky a katastralni
(CUZK). CUZK poskytuje data pro uéely bakalaiskych ¢&i diplomovych praci bezplatng,
v maximalnim rozsahu 4 mapovych listi kladu Zakladni mapy Ceské republiky 1: 10 000.

Byla podana zadost o bezplatné poskytnuti dat a v internetovém obchodé CUZK

byla vytvofena nova objednavka. Zadané podklady jsou nasledujici:

- ZABAGED - polohopis,
- ZABAGED - vyskopis 3D vrstevnice,
- ZABAGED - vyskopis grid 10x 10 m,

- Geonames,

vSechny na stejném mapovém listu 26-11-01. Do nékolika dnti byly soubory pfipraveny ke

stazeni v internetovém obchodé CUZK.

Zakladni baze geografickych dat Ceské republiky (ZABAGED®™) je digitalni
geograficky model uzemi Ceské republiky (CR). ZABAGED" je soudasti informaéniho

systému zemémefictvi a patii mezi informacni systémy vetejné spravy. Je vedena v podobé
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bezeSvé databaze pro celé Utzemi CR, v centralizovaném informa¢nim systému

spravovaném Zemémeétickym uradem.

ZABAGED"je v soufasné dobd tvofena 123  typy geografickych
objektt zatazenych do polohopisné nebo vyskopisné &asti ZABAGED®. Polohopisna &ést
ZABAGED" obsahuje dvourozmémg vedené (2D) prostorové informace a popisné
informace o sidlech, komunikacich, rozvodnych sitich a produktovodech, vodstvu,
uzemnich jednotkach a chranénych uzemich, vegetaci a povrchu, terénnim reliéfu. Jeji
soudasti jsou i vybrané udaje o geodetickych bodech na tzemi CR. Vyskopisnd &ast
ZABAGED" obsahuje trojrozmdmé  vedené (3D) prvky terénniho relicfua je
reprezentovana 3D souborem vrstevnic. (CUZK: Geoportal, 2010)

Dosavadni  digitalni  vyskovy model CR, nazyvany ZABAGED® -
vyskopis 3D vrstevnice, vznikl digitalizaci vrstevnic Zakladni mapy CR 1 : 10 000 v letech
1995 — 2000. Digitalizaci byl vytvofen 3D vektorovy model reliéfu, ze kterého byl
nasledn& odvozen model ZABAGED® — vyskopis grid 10 x 10 m. V nasledujicich letech
Zeméméiicky ufad zajisStoval aktualizaci a zdokonaleni obou modeli pomoci
stereofotogrammetrického vyhodnoceni terénnich hran a vySkovych bodd v rovinatém
uzemi. Timto zpisobem byly odstranény hrubé chyby a c¢astecné inehomogenita
pavodnich modeld, nicmén& presnost, ktera je pro ZABAGED®™ —vyskopis 3D vrstevnice
charakterizovana sttedni vyskovou chybou mp = 0,7 — 1,5 m v odkrytém terénu, 1 -2 m

V intravilanech a 2 — 5 m v zalesnéném uzemi se v zasad€ nezvysila. (Brazdil, 2014)

4.4. Software ArcGIS

ArcGIS pro osobni pocitace se rozd€luje na tii produktové tirovné (licence):

e ArcView nabizi zékladni funkcionalitu pro mapovani, analyzy a nastroje
k jednoduchému editovani a zpracovani geodat.

e ArcEditor je vybaven vSemi funkcemi ArcView, ale navic ma pokrocilé
edita¢ni moZnosti.

e ArcInfo je nejvySsi verzi, ktera obsahuje vSe predchozi a pokrocilé

moznosti zpracovani dat.

ArcView, ArcEditor a ArcInfo maji jednotnou architekturu a uZivatelé pracujici
s kterymkoliv z téchto klienti mohou sdilet vysledky své prace s ostatnimi uZivateli.

Mapy, data, symboly, mapové vrstvy, uzivatelské nastroje a rozhrani, vystupni sestavy,
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metadata atd. mohou byt vzajemné sdileny a vyménovany mezi vSemi tfemi produkty.
Pouziti jednotné architektury pfina$i uzivatelim i tu vyhodu, ze k ovladani kterékoliv

aplikace ArcGIS Desktop se staci naucit ovladat jediné uzivatelské rozhrani.

Zakladnim uzivatelskym rozhranim je ArcMap. Je to centralni aplikace ArcGIS
Desktop, ktera slouzi pro vSechny mapové orientované ulohy vcetné kartometrie,
prostorovych analyz a editace dat. ArcMap je aplikace, ktera poskytuje kompletni

funkcionalitu pro tvorbu mapového vystupu.

Dalsi aplikaci je ArcCatalog, ktery pomaha organizovat a spravovat geodata, jako

jsou mapové Sablony, datové sady, modely, metadata a aluzby.

Funkéné nezbytnou aplikaci je ArcToolbox, ktery obsahuje kompletni sadu funkci
pro zpracovani prostorovych dat, v€etné nastrojii pro spravu a konverzi dat, vektorové i
rastrové analyzy a statistické analyzy. Kazd4 urovenn produktu obsahuje rizny pocet

nastrojii pro zpracovani prostorovych dat. (Klimanek, 2008, s. 8)

4.5. Nadstavba 3D Analyst

Je zaméfena na tvorbu, analyzu a zobrazeni dat ve 3D. Poskytuje jak nastroje pro
interpolaci rastrovych povrchi, tak moznosti pro konstrukci TIN (Triangulated Irregular
Network). Soucasti jsou i nastroje pro mapovou algebru, reklasifikaci rastrii a analyzy
DMT. Soucasti extenze 3D Analyst jsou 1 aplikace ArcScene a ArcGlobe. (Klimanek,
2008, s.9)

ArcScene je prostiedi, ve kterém lze s vytvofenou TIN manipulovat jako
s fyzickym modelem. Lze ji tedy riizn€ otacet, vytvaret efekty pieletu, nebo se po ni

,prochazet®.
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5. TVvORBADMT
5.1. Import dat

V programu ArcMap byl zalozen novy, prazdny projekt. Poskytnuté podklady
mély vSechny nazev souboru podle mapového listu, tj. 26-11-01, a byly pro lepsi orientaci
prejmenovany. V Arc Catalogu jim bylo nutno jesté pied importem pfifadit souradnicovy
systétm (S-JTSK Krovak East-North). Byly tedy pfidany tyto Ctyfi soubory dat
ziskané z CUZK:

- ZABAGED_polohopis.dgn,

- ZABAGED_vyskopis.dgn,

- ZABAGED_grid.shp,

- Geonames.dgn.

Kromé téchto c¢tyf byl jesté vlozen soubor mereni.dgn, obsahujici méfena data a

polohopisnou kresbu podle métickych nacrth.
Z téchto soubori byly nasledné€ vytvoteny 3 modely:

1) Model ZAGAGED grid, vytvofeny ze souboru ZABAGED_grid.shp,
2) Model ZABAGED 3D vrstevnice,zesouboru ZABAGED_vrstevnice.dgn,

3) Me¢feny model mereni, vytvofeny ze souboru mereni.dgn.

Postup tvorby téchto modelt je uveden v nasledujicich kapitolach.

5.2. Tvorba TIN z dat ZABAGED

Nejprve byla vytvofena TIN ze sit¢ 10x10, jednoduse nastrojem Create TIN.
Nastroj ma tfi pole, do pole Output TIN se vlozi umisténi nové vytvaiené TIN, ve
druhém poli se zvoli soufadnicovy systém a do tretiho lze vlozit i vice tiid prvki, ze

kterych se bude TIN vytvaret.

Mapovym listem prochazi statni hranice, a proto neni zcela pokryt siti bodi.
Na okrajich tedy vznikly dlouhé trojihelniky, protoze nastroj Create TIN vytvoii vzdy
konkdvni obrazec. Tyto nesmyslné tvary lze jednoduSe odstranit pomoci nastroje
Delineate TIN Data Area, ktery smaze vSechny linie TIN delsi nez dané délky.
V nasem piipad¢ bylo tfeba ponechat uhlopficné linie ve ¢tvercové siti 10x10 m, nejdelsi

smysluplna délka je tedy 10 - +/2 m, parametr byl proto zvolen roven 15.
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Obr. 11 — Nastroj Create TIN

TIN byla vytvofena stejnym zptisobem z 3D vrstevnic. U tvorby TIN pomoci linii
lze vybrat zpisob, jakym maji byt pouzity. V pfedchozim ptipadé byla TIN tvofena
Z bodu, tedy SE Type (Surface Feature Type) byl zvolen jako Mass Points. U linii je
tato moznost pfitomna také, pak jsou konce tGseCek brany jako body. Vhodnéjsi je vSak
pouziti moznosti Hard Line nebo Soft Line, pak jsou linie brany jako ostré nebo
plynulé hrany terénu. Byla vybrdna varianta Soft Line a probé¢hla tvorba TIN. Opét
byly pomoci funkce Delineate TIN Data Area odstranény piili§ dlouhé (parametr 250)

linie, a to pouze na obvodu TIN (PERIMETER ONLY).
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Obr. 12 — Ndstroj Delineate TIN Data Area
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5.3. Tvorba TIN z méfenvch dat

Protoze v dgn souboru byly vysky bodl dany vyskovymi kotami, a patii tedy do
jiné vrstvy (Annotation) nez bodové i liniové prvky, nepodatilo se jejich obsah pouzit jako
vyskovou informaci pro tvorbu modelu. Resenim bylo néasledné opétovné vloZeni dat do
programu, tentokrat ze seznamu soufadnic (File-> Add Data -> Add XY Data).
Timto krokem se sice pfipravime o povinné hrany, které jsou v dgn souboru, ale tento
nedostatek odstranime V dalsi kapitole. Seznamy soutadnic (podrobnych bodi a bodl
pomocné metické sit€¢) bylo nutné jesté predtim mirné upravit (pfidat zapornd znaménka
pred soutfadnice Y a X a pfidat hlavicku ve spravném tvaru pro identifikaci jednotlivych
poli — soubor je vloZen jako tabulka). V Table of Contents je pro zobrazeni bodi mozno

novou tfidu vybrat a zobrazit vybérem moznosti Display XY Data.

Samotna tvorba TIN pak probé¢hla stejné jako v predchozich piipadech. Pro ofez
vytvoifené TIN vSak byla zvolena jina metoda. V Catalogu byl vytvoien novy shapefile
obvod mereni.shp, [Catalog -> New -> Shapefile; (Feature Type:
Polygon)] az nabidky Editor potom vytvofen novy polygon (Editor -> Create
Features -> Polygon). Na dalSim obrazku je ukézka samotné tvorby obvodového

polygonu méteni, bylo tieba postupné oznacit body na obvodu lokality.
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Obr. 13 — Tvorba obvodového polygonu
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Samotny ofez pak byl proveden nastrojem Edit TIN, do kterého vstupuje
editovana TIN a tfidy prvki, které maji byt do TIN piidany. Pro ofez je tieba vybrat

obvodovy polygon a Vv poli SE Type zvolit moznost Hard Clip.
5.4. Uprava TIN

Protoze byla TIN tvofena pouze z bodi, je potieba do ni nyni pfidat povinné
hrany. To bylo provedeno opét nastrojem Edit TIN, kde jako Input Features
byl pouzit novy shapefile, vytvoifeny z polyline vrstvy souboru mapa.dgn. Tato vrstva
obsahuje vSechny liniové prvky, mezi néz ovSem patii i nékteré mapové znacky, a tak bylo
jesté pomoci vybéru dle atributti nutno vybrat prvky s atributem ,,Cell a ty vymazat.

Zustaly pouze lomové linie, které sice neobsahuji vyskové udaje, ale tyto mohou byt

nacteny Z jiz existujiciho modelu, ktery byl pravé z téchto koncovych bodi linii vytvoien.

(Obr. 14)
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Obr 14. — Nastroj Edit TIN
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V nékterych mistech tvar upravené TIN zjevné neodpovidal tvaru skute¢ného

povrchu terénu, a tak bylo potieba vytvofenou TIN prohlédnout a jest¢ manualné upravit.
K tomu nejlépe vyhovovaly nastroje z liSty TIN Editing, konkrétné Delete TIN
Node — pro odstranéni vrchold, které se vytvofily na hranach, ovSem se Spatnou vyskou, a
ddle Swap TIN Edge, ktery zaméni hranu mezi dvéma vedlejSimi trojihelniky na

alternativni moznost (druhou uhlopficku étyfuhelniku) - Obr. 15.
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Obr. 15 — TIN pred a po manudlni upravé

5.5. Vyhlazeni a export vrstevnic

Vrstevnice je mozno do TIN vykreslit pfimo zkontextové nabidky
Table of Contents (Properties, zalozka Symbology). Pro dal§i praci
s vrstevnicemi je misto této moznosti NUtNO pouZzit nastroj Surface Contour (3D

Analyst -> Triangulated Surface -> Surface Contour), ktery vytvoii
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novy liniovy shapefile s vrstevnicemi o pozadovaném intervalu. Takové vrstevnice vSak

jsou lomené ¢ary, které vypadaji dosti neuspotadang, a velmi neesteticky.

Vyhlazovani vrstevnic je pomérné slozité téma, a existuje mnoho postupti a metod
jak hladkého priabéhu vrstevnic dosahnout. ArcGis funkce piimo pro vyhlazeni vrstevnic
neobsahuje, ma ale nastroje pro vyhlazeni lomené ¢ary (Cartography Tools ->
Generalization -> Smooth Line). Dal$i moznosti bylo vytvotit z TIN rastrovy
model a ten vyhladit pomoci nastroji pro aplikaci filtri (Spatial Analyst ->
Focal Statistics, a zné potom vytvoiit vrstevnice. Byly vyzkouseny obé tyto
moznosti, a lepsi vysledky byly dosazeny pomoci Smooth Line. Ten nabizi na vybér

dva algoritmy: PAEK a Bezierovu interpolaci.

Algoritmus PAEK (Polynomial Approximation with Exponential Kernel) po¢ita
hladké linie pomoci pribézného primérovani. Vysledek zavisi na jednom parametru, ktery
uréuje vzdalenost po linii od pravé pocitaného bodu, do které budou body zahrnuty
K vypoctu. Pfitom se vahy pro kazdy bod zmensuji pravé s touto vzdalenosti po linii od
praveé pocitaného bodu. Kromé primeérovani je pouzita aproximace polynomy druhého
stupn€. Vyhlazend linie nemusi obsahovat zadny z vrcholl pivodni linie (kromé
koncovych bodi). Metoda je stabilni — malé zmény parametru se projevi malymi zménami

ve vysledku.

Bezierova interpolace prolozi kazdym liniovym segmentem Bezierovu kiivku a ty
jsou pak na vrcholech spojeny do hladké kiivky. Algoritmus nevyzaduje zadny parametr.

Vysledna kiivka prochazi vS§emi zadanymi vrcholy.

Porovnani obou algoritmi je na Obr. 16. U algoritmu PAEK byly vyzkouseny
parametry 2; 5 a 10 a v néasledujicim porovnani je pouzit parametr roven 5, ktery asi
nejlépe vystihoval prubéh vrstevnic ve skuteCném terénu (zobrazen modie), Bezierovy
ktivky prubéhu terénu pfilis§ neodpovidaly, (zobrazeny Cerveng), nevyhlazené vrstevnice

predstavuji erné lomené Cary.
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Obr. 16 — Algoritmy Smooth Line

Vrstevnice byly po vyhlazeni exportovany do formatu dgn, toto 1ze provést
Z kontextového menu Table of Contents,polozka Data -> Export to CAD.
Otevfe se nastroj Export to CAD, v némz se z nabidky riznych format zvolil pravé dgn.

Vyexportované vrstevnice byly nasledné vloZeny do souboru ucelova mapa.dgn.

5.6. Porovnéani vytvofenych modelu

Puvodné, viz str. 27, byly vytvotfeny tii modely terénu. Prvni model, vytvoieny ze
sit¢ 10x 10 m, nebyl dale pouzit, z divodu pouziti vyhodnéjsiho vrstevnicového modelu.
Druhy vytvotreny model je tedy z vrstevnic ZABAGED. Tteti model je vytvoreny z piimého
meéfeni v terénu. Pro ziskani predstavy, jak se lisi model ZABAGED - vrstevnice
od mé&feného modelu muze poslouzit Obr. 17, vytvofeny pomoci ArcScene, kde se tyto

modely protinaji. Zluté je zobrazen méfeny model, zelend model z vrstevnic ZABAGED.
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I model ZABAGED-vrstevnice
[ I méFeny model

Obr. 17 — Protinajici se modely v ArcScene

Pro porovnani obou modelt byly zvoleny profily v 20m rozestupu. Byl vytvoien
novy pomocny liniovy shapefile profily.shp, a zvolena poloha prvniho profilu.
Pomoci piikazu Copy Parallel V Editoru pak vznikly rovnobéZné linie ve
vzdalenosti pozadovanych 20 metri. Dale bylo potieba tyto linie ofiznout pouze na
méfenou lokalitu, k tomu byl pouzit nastroj Clip (Analysis Tools -> Extract
-> Clip).V Input Features byl zvolen ofezavany shapefile s profily a jako C1ip
Features, tedy soubor podle kterého se bude ofezavat, jiz diive (Strana 29) vytvoreny
shapefile obvod mereni. Output Feature Class je vystupni shapefile

profily clip.

Shapefile profily obsahuje pouze pfimky, kterym je nyni tieba pridélit vysky
z vytvofenych modeld. Pro toto byl pouzit nastroj (3D Analyst Tools ->
Functional Surface -> ) Interpolate Shape. Tento nastroj byl pouzit
stejnym zpusobem dvakrat, pro kazdy srovndvany model byl vytvofen jeden soubor
profild. Nastroj je intuitivni, prvni polozka Input Surface je zdrojovy model pro
interpolaci vySky. Input Feature Class je shapefile, kterému vysku urcujeme
(profily.shp). Output Feature Class je novy vystupni soubor
(profily ZABAGED.shp a profily merene.shp). Zbylé polozky nebylo tfeba

nastavovat. Pomocny soubor profily. shp byl po dokonceni odstranén.
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Nyni byly pokazdé vybrany ,,soubézné linie z obou shapefilti a pomoci ptikazu
Profile Graph z nastrojové listy 3D Analyst vytvoieny grafy. Piehled téchto profild je
v ptiloze Cislo 9 a samotné grafy profila Vv piiloze ¢. 10, ukdzka jednoho z vytvoienych

graft je na Obr. 18.

T BAGED
gasz : s A~ Ve | — méer

o 2 4 B g mo12 1M 1B 1w 20 XL % 2%/ 28 T 3L M 3F 3\ 40 2 44 M8 48 80 52 54 s6 SB ED EX
déka [m]

Obr. 18 — Ukdzka profilii — profil ¢. 2

Kromé terénnich profild bylo pomoci nastroje Surface Difference
vytvoreno grafické vyjadieni rozdili vySkopisu modelu ZABAGED - vrstevnice a modelu
méfeného terénu. Do tohoto nastroje byl jako Input Surface vlozen model
z méfenych dat a jako Reference Surface model ZABAGED - vrstevnice. Output
Feature Class je vystupni polygonovy shapefile, ktery pouze rozdéluje pocitanou
oblast na polygony ,,pod* a ,,nad®, referenénim modelem. Pro vyjadieni vySkovych rozdili
formou TIN je nutno vyplnit polozky Output TIN Folder aOutput TIN Base
Name (anebo Output Raster a Raster Cell Size pro rastrovy vystup). Timto
zpusobem vytvofena TIN zobrazuje vyskové rozdily mezi modely a umoznuje zjistit, ve
kterych mistech byly tyto rozdily maximalni, a kde se naopak modely pftiblizovaly
a protinaly. Toto grafické vyjadieni rozdila vyskopisu modelu ZABAGED - vrstevnice

a modelu méfeného terénu je na Obr. 19 a je obsahem pfilohy €. 11.
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Obr. 19 — Grafické zndzornéni rozdilit vyskopisu vytvorenych modelit

Vytvoiené modely se lisi, jak jasné vyplyva ze srovnani vrstevnic méteného
modelu s pravé vytvofenym grafickym porovnanim nejvice v mistech, kde se nachazely
hluboké tézebni jamy. Maximalni rozdil je 10,5m, coz piekracuje stiedni vyskovou chybu
vrstevnic ZABAGED v zalesnéném tzemi, ktera je udavana m,=2-5m. Dtvodem takto
velkého rozdilu mize byt neobvykly tvar terénu, tzn. plosné malé, ale hluboké tézebni
jamy, které mohly byt v meétitku 1:10 000, z né¢hoz data ZABAGED pivodné vychazi,

kartografickou generalizaci pominuty.

5.7. Polohopis

Nakonec byl proveden ofez modelu ZABAGED-vrstevnice, a to na hranice
katastralniho tzemi Kojkovice u Ttince. Pro ofez nastrojem Edit TIN je nutné mit
k dispozici shapefile, kterym se bude ofezavat. Ten byl vytvoien z polohopisu ZABAGED,
konkrétné jde o vrstvu 60, hranice spravni jednotky ak.u. Postup byl takovy, zZe

v kontextovém menu vrstvy polyline se vybrala moZnost Properties, a Vv zaloZce
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Drawing Layers se zobrazila pouze vrstva 60. Poté bylo mozné vrstvu vyexportovat
z forméatu dgn do shapefilu (moznost Export Data Vkontextovém menu Table
of Contents). Vznikl shapefile obsahujici hranice k.0. na celém mapovém listu, proto
byly pomoci Editoru odstranény nepotiebné linie a ponechdny pouze hranice k.u.

Kojkovice u Ttince. Otfez byl potom proveden jiz dfive popsanym néstrojem Edit TIN.

Podobné byly vytvofeny dal§i shapefily obsahujici budovy, komunikace,
zalesnénou pudu a vodni toky. Tyto shapefily byly néstrojem Interpolate Shape, (ktery je
popsan v piedchozi kapitole béhem tvorby profilit) umistény na 3D model. Nasledné bylo
otevieno prostiedi ArcScene, a do néj vloZeny ob& TIN a pravé vytvorené shapefily, které
vytvofily model, jaky lze vidét na Obr. 19. Stromy byly vygenerovany nastrojem Create
Random Points. Budovy jsou pouze liniové prvky zviditelnéné moznosti Extrusion

V Layer Properties.
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Obr. 20 — 3D model v prostredi ArcScene
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6. ZAVER

V této bakalarské praci byl vytvofen 3D model vybrané lokality v obci Kojkovice

u Ttince. Pro tvorbu byla pouzita data ziskana pfimym méfenim v terénu.

Bylo zaméteno celkem 904 podrobnych bodi, ze 48 bodii pomocné meétické site.
Me¢fteni bylo registrovano do péti zapisnikii a v jeho prubéhu bylo vyhotoveno devét
méfickych naértti. Méfeni bylo zpracovano v programu Groma a v programu Microstation

byla vyhotovena tu¢elova mapa.

Nasledné byly soufadnice bodi vlozeny do programu ArcMap, kde z nich byl
pomoci nastroji nadstavby 3D Analyst vytvoren digitdlni model terénu ve forme TIN,

a z n¢ho potom vrstevnice.

Kromé& naméfenych dat byla vyuzita i data ZABAGED poskytnuta CUZK a z nich
byl podobnym zpisobem vytvoien druhy model. Oba modely byly porovnany. Pro tento
ucel byly vyhotoveny terénni profily ve vzdalenosti 20 metrt, a pro lepsi piehlednost také
graficky znazornény rozdily mezi obéma modely. Rozdily dosahuji v nékterych mistech
hodnoty 10 metrli, coZ muze byt zplsobeno nepfirozenym tvarem terénu jako dusledku

provedené tézby vapence v méfené lokalité.

Hlavnim vystupem této bakalaiské prace je 3D model métené lokality ulozen na
pfilozeném CD. Tento model muze byt dale pouzit napiiklad pro vizualizaci budouci

zastavby.
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SEZNAM POUZITYCH ZKRATEK A SYMBOLU

GIS — Geograficky informacni systém

ZABAGED - Zakladni baze geografickych dat

S-JTSK - Systém jednotné trigonometrické sit¢ katastralni

Bpv — Vyskovy systém baltsky po vyrovnani

PBPP — Podrobné bodové polohové pole

ZBPP — Zékladni bodové polohové pole

GNSS — Global Navigation Satellite Systém — Globalni polohovy druzicovy systém
DR — Direct Reflex — Ptimy odraz

MNC — Metoda nejmensich &tverci

DMT — Digitalni model terénu

TIN — Triangulated irregular network - nepravidelna trojuhelnikova sit’

PAEK — P olynomial Approximation with Exponential Kernel

41



3D model obce Kojkovice u Tfince
Krzysztof Szturc

9. SEZNAM OBRAZKU
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Vyznaceni zadané lokality. Zdroj: https://maps.google.com/
Fotografie lokality

Fotografie lokality

Trimble Zeiss 3603 DR

Ukéazka métického nacrtu

Vypocet polygonového poradu

Vypocet rajonu

Trigonometrické urceni vysky

Vypocet polygonového potadu v programu Groma
Vyrovnani sité¢ v programu Groma

Nastroj Create TIN

Nastroj Delineate TIN Data Area

Tvorba obvodového polygonu

Nastroj Edit TIN

TIN pted a po manudlni tpravé

Algoritmy Smooth Line

Protinajici se modely v ArcScene

Ukézka profili — profil ¢. 2

Grafické znazornéni rozdilt vyskopist vytvorenych modeli

3D model v prostiedi ArcScene
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